
The Most Trusted Name in Measurement

 BlendMate  
BlendMate for miniBlend.net 

Installation/Operation
Bulletin MNMB006 Issue/Rev. 0.0 (3/11) 



 

 

Caution 
The default or operating values used in this manual and in the program of the  
miniBlend.net are for factory testing only and should not be construed as default or op-
erating values for your metering system. Each metering system is unique and each pro-
gram parameter must be reviewed and programmed for that specific metering  
system application. 
 
 

Disclaimer 
FMC Technologies Measurement Solutions, Inc. hereby disclaims any and all responsi-
bility for damages, including but not limited to consequential damages, arising out of or 
related to the inputting of incorrect or improper program or default values entered in 
connection with the miniBlend.net. 
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Product Description 

BlendMate for miniBlend.net is a Windows application that facilitates configuration of the Smith Meter miniB-
lend.net series of electronic presets. BlendMate allows the user to configure existing parameters, create custom 
reports, translate miniBlend.net interface text, and create custom equation sets.  

BlendMate supports context-sensitive help. Press "F1" from any location for detailed help on a particular feature, 
or select "Index" from the Help menu to browse the index. 

A CRC table is maintained for each revision of miniBlend.net. When communication is established with a unit, the revision 
is examined. Any discrepancies, such as an unknown revision or a type mismatch, are reported to the operator.   

BlendMate allows the user to work with several files simultaneously. In the context of the BlendMate, a "file" is the 
data associated with one miniBlend.net. When multiple files are open, the currently active window is the one that 
will be affected by menu choices and toolbar options. 

Modes of Operation 
Offline Mode 

In the Offline mode of operation, the BlendMate can be used to completely set up a data file or edit an existing 
file. This file can then be saved for future use. By switching to Online mode, the file can be downloaded to the mi-
niBlend.net. 

Online Mode 

The Online and Read Only modes of operation require that the miniBlend.net and the BlendMate's communica-
tions port are configured with the same baud rate, parity, protocol, and address. In addition, a file should be 
created for each miniBlend.net with which the BlendMate is to communicate. A file is created by selecting "File" in 
the upper left-hand corner of the BlendMate's toolbar, then selecting "New," then "miniBlend.net Data File." 

Read Only Mode 

Read Only mode is used to read information from the miniBlend.net. The program may enter the Read Only mode 
for one of several reasons, including insufficient security access, transaction in progress, already in program 
mode at keypad, or an incorrectly programmed communications port control. An error message will appear. If the 
operator clicks "OK" and presses "ENTER" on the computer keyboard, the BlendMate will automatically go into 
the Read Only mode and no data will be exchanged. 

Once the setup is complete, communications can be established and information can be passed between the  
BlendMate and the miniBlend.net. 

When in the Online mode, the BlendMate can be used to configure the miniBlend.net, read information from the 
miniBlend.net, and dump directories or entire files to the miniBlend.net. Information is sent to the miniBlend.net by 
using the "dump" icons on the BlendMate toolbar.  

Online Help 

To access BlendMate's built-in help function, type Alt-H from the keyboard or click on "Help" at the top right of the 
BlendMate screen. These actions display the Help menu. Select "Contents" for an index of built-in help topics. 
The operator can also press F1 at any time for context-sensitive help. 

System Requirements 

The BlendMate will operate on an IBM-PC compatible computer operating in a Windows environment (Windows 
95 or later) with at least 4M of memory. The hard drive should have at least 2M of free disk space.   
BlendMate is available for download over the internet at http:// www.fmctechnologies.com/measurementsolutions/ 
onlineservices/software.aspx. 
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Installing BlendMate  

To download the BlendMate over the Internet, do the following: 

1. Go to http://www.fmctechnologies.com/measurementsolutions/onlineservices/software.aspx. 

2. Select BlendMate for miniBlend.net 

3. Select the version required. 

4. When prompted with ‘Do you want to run or save this file?”, select Run. 

Follow the prompt to complete the download and installation of BlendMate.
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Program Files  

During the installation process, the following files will have been copied to the PC's hard drive. These files may be 
viewed by opening Windows Explorer and selecting the BlendMate directory. 

BlendMate for miniBlend.net 
• blendMate.cnt 
• blendMate.exe (launches the program) 
• blendMate.hlp (contains online help) 
• blendMate.gid 
• blendMate Data Template.xlsm 
• Default Settings.MLB 
• Default Prove Report.RPB 
• Default Trans Report.RPB 
• Sample Display.DPB 
• Sample Equations.EQB 
• Uninst.ISU 
 
Contact a Smith distributor if any of these files are missing, or if there are any other problems with the BlendMate 
installation. 
 

File Extensions 
miniBlend.net file names are typically followed by a two- or three-letter extension (e.g., .MLB). The extension indi-
cates the nature of the file. 
 
• .MBL files – miniBlend.net configuration files 
• .RPB files – miniBlend.net configurable report definition files 
• .DPB files – miniBlend.net display definition files 
• .EQB files – miniBlend.net equation files. 
• .LGB files – miniBlend.net translation files 
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Establishing Communications 

In order for communications to function, the miniBlend.net and BlendMate setups must be compatible and the 
communications cable correctly wired. Several miniBlend.net parameters (including communications port, baud 
rate, data bits, and parity) must be properly set to enable communications. The BlendMate setup must then be 
configured to match the miniBlend.net parameters. 

Serial Communication Cable Wiring 

Select an available communications port. COM1 is configured for the BlendMate by default in the miniBlend.net. 
Only three wires are necessary for EIA-232 serial communications. They must be connected as shown in the  
diagrams below. 

 

Figure 1. Nine Pin Communications Connector Wiring 
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Figure 2    25 Pin Communication Connector Wiring 
 
Good shielding practices are recommended when wiring communications cables. The DB-25 connector has a pin 
dedicated to shield (Pin 1). Pin 1 is not a shield pin on the DB-9 connector. Connect (solder) the shield conductor 
to the DB-9 connector’s metal case. If that is impractical, in most cases it is acceptable to terminate the shield at 
Pin 5 along with the signal ground. It is not recommended that shield wiring be terminated at the miniBlend.net, 
especially in multi-drop environments. 

Due to the fact that the miniBlend.net serial ports have additional hardware to allow multiple units to share a sin-
gle EIA-232 port, the PC’s receive pin is left in a floating state during idle time. This can result in some PCs (es-
pecially laptop computers) being susceptible to echo, which can interfere with the serial communications reliabili-
ty. Sometimes installing a resistor (~1K) between miniBlend.net TX and COM can improve communications in 
these situations. For example, on miniBlend.net COM1, the resistor would be installed (like a jumper) from CN2-1 
to CN2-5. 
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Ethernet Cable Wiring 

Ethernet cable must meet the requirements of CAT5 at a minimum.  Direct Ethernet connections between com-
puter and miniBlend.net require a crossover cable configuration.  Standard straight cable configuration is used 
where the miniBlend.net units are networked through a hub or switch.  An Ethernet connection at the mini-
Blend.net is made by a RJ-45 connector labeled CN-8 located on the MNET circuit board. 

Communications Port Setup 

Each miniBlend.net file stores the address used for communications, the PC port to which it is attached, and other 
important information. Because each miniBlend.net has its own file, there is no need to change communications 
settings when moving among multiple miniBlend.nets connected to the same PC (as in a load rack environment, 
for example). All miniBlend.nets on the same PC comm port must have the same port settings and protocol (ei-
ther terminal or minicomputer).  

To begin communicating with the BlendMate, set up the communications port using the Options|Options for this 
miniBlend.net… menu choice. The dialog presented allows for setup of both the communications port and the 
communications protocol. 

Ethernet users need only select “TCP/IP” from the Com Port dropdown list and enter the IP address of the mini-
Blend.net in the “miniBlend.net Address” data.  No further “Comm Settings” are required. 

To set up a serial communications port, first determine the available communications ports on the PC. If COM1 is 
available (not connected to a mouse, modem, or some other device), connect your communications line to the 
COM1 (Serial Port 1) connector on the back of the PC. Select COM1 in the combo box. (See Figure 3.)  If both 
are in use, select either COM3 or TCP/IP if present. Be aware that in most PCs, COM1 and COM3 cannot be 
used simultaneously, nor can COM2 and COM4 be used simultaneously. Extender boards for serial communica-
tions (e.g., DigiBoards) can be used as long as they support the Windows communications API standard. 

Another alternative is to use SLIP (Serial Line Internet Protocol).  SLIP uses a miniBlend.net serial communica-
tions port to employ TCP/IP communications with a minicomputer type device.  (Refer to miniBlend.net Commu-
nictions Manual MNMB004, Appendix VI for information on setting up SLIP communications.) 

To configure the communications settings, open an existing miniBlend.net file or create a new one, then select 
Options|Options for this miniBlend.net... Click the "Comm Settings" button on the dialog box to select the desired 
baud rate (38,400 is recommended), using the same baud rate for both the BlendMate and the miniBlend.net. Da-
ta/Parity must be 8 Bits, No Parity (8 Bits None). Because some data transfers are binary, all eight bits are 
needed for the data. 
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Figure 3    Communications Setup 
 

Initiating Communications with the miniBlend.net 

To configure the miniBlend.net for communications, do the following: 

1. Connect the selected PC communications port to a miniBlend.net communications port. 

2. Select an existing miniBlend.net file, or create a new one, by choosing "Open" or "New" under "File" on the 
BlendMate toolbar. 

3. A display similar to that shown below will appear on the computer screen. Communication configuration pro-
gram codes are in the "700" System Communications group, as shown in Figure 4.. 

4. To configure an option, use the mouse to select the appropriate program code and then double click. A dialog 
box will appear that allows the user to enter information for that parameter. 

Example: To specify the comm address for a specific miniBlend.net, choose "704: miniBlend.net Comm 1 
Control." From the pulldown list select the degree of control to be exercised from Comm. 1 and click "OK." 
The miniBlend.net's Control Mode will appear in the right-hand column labeled "Value." 
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Figure 4    Communications Directory 
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Figure 5    Comm Control Example 
 
 
Note: Unless automation level control is desired, choose Poll & Program for the BlendMate in the Comm Control parameter. Poll & Program is 
also a good selection for demonstrations, since it allows batches to be run without remote authorization. 

For detailed information about program codes, refer to the miniBlend.net Operator Reference Manual, MNMB002. 

Once the communications configuration is complete, do the following: 

1. Open a miniBlend.net data file. Select Options|Options for this miniBlend.net, and verify the miniBlend.net 
address.  

2. Verify that the communications port is set to the port on the PC, and that the selected protocol matches that 
programmed at the miniBlend.net.  

3. If the parity and baud rate are not correct, change them using the "Comm Settings" button in the dialog box. 

4.  Close the "Options" dialog. 

If all is working properly, the status bar text (at the bottom of the screen) should change from "Offline" to "Online" 
mode. If the status bar indicates "Read Only," verify that the miniBlend.net is not in Program mode at the keypad, 
and that all programmed security requirements have been met at the miniBlend.net. 
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Troubleshooting 

If difficulty is encountered, verify the accuracy of the following: 

• Communications setup at the BlendMate 
• Communications setup at the miniBlend.net 
• Port, baud rate, and parity 
• Protocol (Terminal or Minicomputer); minicomputer is recommended 
• miniBlend.net address 
• Wiring between the miniBlend.net and the PC (Are transmit and receive connections reversed? Is the cable 

connected to the proper comm port at both the miniBlend.net and the PC?). 
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Program Startup [start here] 

The BlendMate, when launched, will open to a screen similar to that shown in the figure below. An operator can 
work with more than one file at a time. In the context of the BlendMate, a "file" is the data associated with one 
specific miniBlend.net. Multiple miniBlend.net files can be open at one time as separate documents on the desk-
top. 

   
  

 

Figure 6    BlendMate Startup 
 

.  

 
Data and Functions 

The data and functions that can be accessed or accomplished from this screen are as follows. 

File Menu 

Access the File menu by clicking "File," which appears at the far left of the BlendMate menu bar (at the top of the 
BlendMate screen). 
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New: A new miniBlend.net data file will be created. (Other functions available under "New," including "Report 
Configuration," "Translation," "Equation Set" and “Display Configuration” will be discussed in other sections of this 
manual.).  

Open: Opens an existing miniBlend.net file. 

Close: Closes an open miniBlend.net file. 

Save: Saves changes to the current file to disk. 

Save As: Displays a dialog box that allows a new name to be assigned to a file. 

Print: Prints either the current directory or all the parameters in the active miniBlend.net file. 

Print Preview:  Displays a preview on the screen of what would be printed.  

Print Setup:  Displays a dialog box which provides means for altering printer properties and settings. 

Exit: Exits the program. 

Edit Menu 
Access the Edit menu by clicking "Edit" on the BlendMate menu bar. 

Cut: Removes the selected text and places it on the clipboard. 

Copy: Copies the selected text and places it on the clipboard. 

Paste: Inserts the text stored on the clipboard at the location of the cursor. 

Read Selected Folder: Loads values from the miniBlend.net into the currently selected directory or sub-
subdirectory. "Read Selection" can also be activated by clicking its icon on the BlendMate toolbar. From 
either of these options, the operator can choose to read a specific directory from the active  
miniBlend.net. When the data reading is complete, the program will return to the previous screen. 

Read All: Reads all values associated with the active file from the miniBlend.net. "Read All" can also be 
activated by clicking its icon on the BlendMate toolbar. From either of these options, the operator can 
choose to read all data from the active miniBlend.net. When the data reading is complete, the program 
will return to the previous screen. 

Dump Selected Folder: Sends the current selection to the miniBlend.net. "Dump Selection" can also be 
activated by clicking its icon on the BlendMate toolbar. From either of these options, the operator can  
choose to download a specific directory to the active miniBlend.net. When the data transfer is complete, 
the program will return to the previous screen. 

Dump All: Sends all data in this file to the miniBlend.net. "Dump Selection" can also be activated by 
clicking its icon on the BlendMate toolbar. From either of these options, the operator can choose to  
download all data from the BlendMate to the active miniBlend.net. When the data transfer is complete, 

the program will return to the previous screen. 
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Tools Menu 

The Tools menu is accessed by clicking "Tools" on the BlendMate menu bar. (This menu is only available for 
.MLB files) 

Terminal Emulator (Alt-F10): The Terminal Emulator is a "smart" terminal emulator that formats commands to 
be sent to the miniBlend.net. It is accessed by selecting Tools|Terminal Emulator from the BlendMate toolbar. 
Terminal Emulator supports both Terminal and Minicomputer modes, and processes all required framing charac-
ters. The operator types only the actual command and any associated command qualifiers. From this interface, 
the operator can send any of the commands in the miniBlend.net repertoire. 

The Terminal Emulator features a pull-down menu, Commands, on the toolbar. From this menu, the operator can 
browse all commands in the miniBlend.net command set. As each command is highlighted, information about the 
command will appear on the application's status bar. Once an item is selected, pressing "F1" will display the help 
message for that particular command. If a command requires no additional information, it will be sent immediately. 
The pull-down menu at the upper right-hand corner of the terminal emulator display allows the operator to select 
the arm with which communications will interact. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7    Terminal Emulator Commands 
 
Refer to the miniBlend.net Communications Manual, MNMB004, for additional information about miniBlend.net 
commands. 
 
Transaction Log to File…: This feature creates a backup of transaction data on disk. Its purpose is to prevent 
complete loss of data when reinitializing a miniBlend.net, such as when upgrading software. Because initialization 
erases the miniBlend.net's flash memory, the transaction log is destroyed. 

When "Transaction Log to File" is selected, the operator will be prompted to select a file name. The default name 
is (miniBlend filename)-TransLog.txt. The file will be saved in a comma-delimited text format that may be opened 
in a spreadsheet program, such as Microsoft Excel, that sorts the data into readable columns based on the 
placement of commas in the text. 

Note: This option is only available when the miniBlend.net is online and its file is open and active on the BlendMate. 
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Event Log to File…: This feature creates a backup of event data on disk. Its purpose is to prevent complete loss 
of data when reinitializing a miniBlend.net, such as when upgrading software. Because initialization erases the 
miniBlend.net's flash memory, the event log is destroyed. 

When "Event Log to File" is selected, the operator will be prompted to select a file name. The default name is (mi-
niBlend filename)-EventLog.txt. The file will be saved in a comma-delimited text format that may be opened in a 
spreadsheet program, such as Microsoft Excel, that sorts the data into readable columns based on the placement 
of commas in the text. 

Note: This option is only available when the miniBlend.net is online and its file is open and active on the BlendMate. 

Audit Trail Log to File…: This feature creates a backup of audit trail data on disk. Its purpose is to prevent com-
plete loss of data when reinitializing a miniBlend.net, such as when upgrading software. Because initialization 
erases the miniBlend.net's flash memory, the audit trail log is destroyed. 

When "Audit Trail Log to File" is selected, the operator will be prompted to select a file name. The default name is 
(miniBlend filename)-AuditLog.txt. The file will be saved in a comma-delimited text format that may be opened in a 
spreadsheet program, such as Microsoft Excel, that sorts the data into readable columns based on the placement 
of commas in the text. 

Note: This option is only available when the miniBlend.net is online and its file is open and active on the BlendMate. 

Retry Communications: This feature sends a status request to the miniBlend.net to determine the viability of 
communications between the BlendMate and the miniBlend.net. This command is generally used after changes to 
communications settings to ascertain the current communication status, or after using the "Go Offline" command. 

Go Offline: Terminates communications between the BlendMate and the miniBlend.net, allowing the operator to 
make changes to the file that do not immediately affect the miniBlend.net. 

Upgrade Firmware…

1.  Back up all data on the miniBlend.net using BlendMate before upgrading anything. Make sure your 
.mlb file representing the miniBlend.net settings is up to date: Open the appropriate miniBlend.net (.mlb) 
file. Perform a Read All. Save the file.  

: There are occasions where new features / enhancements are made to the miniBlend.net 
software package, requiring the end user to perform an upgrade procedure to obtain these new features. Because 
each revision of miniBlend.net firmware released by Smith Meter is accompanied by a revision to BlendMate, up-
grade both BlendMate and miniBlend.net together (There may be rare exceptions to this, in which case some no-
tification will be made). The following recommendations are designed to ease this operation and ensure that the 
upgrade goes smoothly: 

2.  If any of the following items exist at the miniBlend.net (and you do not already have them stored) read 
and store them as well: Report Configuration(s) (.RPB), Translation (.LGB) and custom Boolean/Algebraic 
equation set (.EQB). (Note: To read these items, you must be in the appropriate editor for the item… so 
create a dummy file, then select read all. For example, if you want to read out the current Report Configu-
ration, select File | New | Report Configuration once you are online and then, while the new file is active, 
select Read from the Edit menu or toolbar) 

3.  Retrieve the event and transaction logs using BlendMate if desired via the Tools menu. This informa-
tion will be lost when the miniBlend.net is initialized. 

4.  Install the new BlendMate revision. Install to the same directory as your original revision for best re-
sults. You may wish to back up the directory beforehand. 

5.  Select Tools | Upgrade Firmware from the BlendMate menu and follow the instructions. 
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6.  Enter Program Mode, go to the Diagnostics menu, and perform a factory database initialization. This 
will erase the program configuration database, and set all program codes to known values. You can then 
re-enter program mode (the passcode will be 0 again) 

7.  Via the miniBlend.net keypad, program the communications port for BlendMate communications.   
(See Initiating Communications with the miniBlend.net). Enter a valid K-Factor (Product directory program 
code 301). Re-enter any security codes you had programmed. Exit Program mode via the keypad. 

8.  In BlendMate, open the .ml file that you saved in step 1. Verify that communications is established 
(unit should be in ONLINE mode). Select Dump All. 

9.  Download any files stored in step 2 in the same manner. 

Browse miniBlend…

 

: Browses the miniBlend.net’s web page with a web browser.  The miniBlend.net acts as a 
simple embedded server for the page.  Current run data may be viewed from the page. 

Figure 8    miniBlend.net Browser 
   

 

 

Options Menu 

Access the Options menu by clicking "Options" on the BlendMate menu bar. 
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Options for this miniBlend.net…: This selection allows the operator to configure communication settings for a 
specific miniBlend.net.  

General…: Display and printing options can be selected by modifying entries in the Options dialog box (shown in 
Figure 10). The Options dialog box is accessed by selecting Options|General… . 

Display Options: Click with the mouse in the box beside "Display Security Level in List View" to add the Security 
Level for the parameter to the parameter list view. Click again to suppress this option. 

Printing Options: Click with the mouse in the box beside "Suppress Printing Unused Recipes" to avoid printing 
recipes that are programmed as "Not Used" in Recipe Parameter 001. Click again to suppress this option. 

Click with the mouse in the box beside "Include Security Level on Printout" to add the Security Level for the para-
meter to the printed list. From the pull-down menu to the right of "Limit printout of parameters to:", select the secu-
rity level that determines which parameters are to print. Click again to suppress this option. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9    General Options 

View Menu 

Access the View

Toolbars: Shows or hides the toolbar near the top of the BlendMate screen. 

 menu by clicking "View" on the BlendMate menu bar. 

Status Bar: Shows or hides the status bar at the bottom of the BlendMate screen. The status bar indicates 
whether the BlendMate is online or offline, as well as the current communications settings and status.   

Split: Allows the user to allocate space between the BlendMate Panes being displayed. 
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Figure 10    View Menu 
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Editing Program Code Data 

To edit program code data, first open a new or existing miniBlend.net data file. Do this by selecting "New" or 
"Open" from the File menu on the BlendMate toolbar. If "New" is selected, choose "miniBlend.net Data File" from 
the pop-up menu. If "Open" is selected, choose an existing miniBlend.net file from the File dialog menu. Mini-
Blend.net files are designated by the file extension ".mlb".  

A list of directories will appear on the left of a split screen in the active miniBlend.net window. (Refer to the Opera-
tor Reference Manual, Bulletin MNMB002 for detailed information about directories and the program codes within 
each directory, or click on "Help" at the far right of the BlendMate toolbar.) Clicking on "Communications," for ex-
ample, causes a listing of all program codes within the Communications Directory to appear on the right-hand 
screen, as shown in Figure 11. Double-click on one of these program codes to display a dialog box. 

This dialog box, "Edit Program Code Data," contains information about the selected program code. For the cur-
rently-selected code, this dialog box provides a pull-down menu with all valid options and value ranges, or a text 
box for text program codes. When new information is selected from the pull-down menu, the new value appears 
on the active miniBlend.net data file screen. 

 

Figure 11    Communications Directory 
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To access the program code dialog box shown in Figure 12 select "Configuration" | “Pulse Outputs” then double-
click on "101 Pulse Output Function" in the right-hand window. The dialog box will then appear. 

 

 

 

 

 

 

 

Figure 12    Parameter Editing 
 
The program code shown in Figure 12 has a pull-down pick list. To access the pick list, use the mouse to click on 
the down arrow at the right of the box labeled "New," then highlight the desired option and click OK. 
If the miniBlend.net is currently online and communication with the BlendMate is active, the new value will be ef-
fective after a few seconds; otherwise, the value change will have to be dumped to the miniBlend.net when com-
munication is established. 

Other dialog boxes require the operator to type in alphanumeric data. An example of this is the box shown in Fig-
ure 13. This particular box is selected by clicking on "General Purpose," then highlighting "112 Flow Rate Descrip-
tor" from the menu of program codes in the window on the right. The resulting dialog box prompts the operator to 
type up to three characters (in any combination of letters and/or numbers) in the box labeled "Enter New Value." 
Once the updated information has been typed in the box, the operator clicks on OK to save the current data. The 
new data will appear in the "Value" column in the window on the right. 

 

 

 

 

 

 

 

 

Figure 13    Parameter Editing 
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The third type of dialog box allows only numeric entries. An example of this type of box is shown in Figure 14. 
This particular box is selected by clicking on the “General Purpose” menu, then highlighting "131 Dynamic Display 
Timeout." The dialog box prompts the operator to enter a number from zero to 99. Once the updated information 
has been typed in the box, the operator clicks on OK to save the current data. All boxes of this type display help 
messages that include the range of the entry and other pertinent information. 

 

 

 

 

 

 

 

Figure 14    Parameter Editing 
 
Finally, there is the dialog box listing available options selectable with check boxes, as shown in Figure 15. To ac-
tivate an option, the operator uses the mouse to position the cursor in the box to the left of the desired option, 
then clicks once in the box. A checkmark appears to indicate that the option has been selected. To deactivate an 
option, position the cursor on the check and click once with the mouse. The checkmark will disappear. Click on 
"OK" to store changes. The new selection will appear in the value column in the window on the right. Access the 
dialog box by choosing “Alarms," then "System 642 Low Density Alarm."  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 15    Parameter Editing 
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Using the Terminal Emulator 

The Terminal Emulator is a "smart" terminal emulator that formats commands to be sent to the miniBlend.net. It is 
accessed by selecting Tools|Terminal Emulator from the BlendMate toolbar. Terminal Emulator supports both 
Terminal and Minicomputer modes, and processes all required framing characters. The operator types only the 
actual command and any associated command qualifiers. From this interface, the operator can send any of the 
commands in the miniBlend.net repertoire. 

The Terminal Emulator adds a new pull-down menu, "Commands," to the menu bar. From this menu, the operator 
can browse all commands in the miniBlend.net command set. As each command is highlighted, information about 
the command will appear on the application's status bar. Once an item is selected, pressing "F1" will display the 
help message for that particular command. If a command requires no additional information, it will be sent imme-
diately. 

Refer to the miniBlend.net Communications Manual, MNMB004, or the imbedded “HELP” feature for additional in-
formation about miniBlend.net commands. 
 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 16    Terminal Emulator Window 
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Report Editor 

The Report Editor uses a combination of basic Windows commands (e.g., Cut, Copy, and Paste) and simple val-
ue descriptions to create customized reports. Access the Report Editor by selecting File|New|Report Configura-
tion from the BlendMate menu bar. 

"Insert New Item," "Edit Selected Item," "Cut," "Copy," and "Paste" are accessed by clicking "Edit" on the Blend-
Mate toolbar, then selecting the desired option from the pull-down menu. 

Insert New Item Opens a dialog box from which a new item can be added to the report. 

Edit Selected Item Opens a dialog box from which an existing report item, when highlighted, can be 
modified. 

Cut The item highlighted on the Report Editor will be cut from the display and stored 
on the clipboard. 

Copy The item highlighted on the Report Editor will be copied to the clipboard. 

Paste The information stored on the clipboard will be pasted to the Report Editor  
window at the specified row and column. 

Read Report from  
miniBlend.net 

Uploads a report from the miniBlend.net. (This option is only available when the 
BlendMate is online.) 

Dump Report to 
miniBlend.net 

Downloads a report to the miniBlend.net. (This option is only available when the 
BlendMate is online.) 

"Line," "Column," "Item Type," "Item Value," and "Format String" are accessed by moving the cursor to the appro-
priate option on the "Edit Report Item" dialog box. The "Edit Report Item" box appears whenever an existing re-
port item on the Report screen is double-clicked.  

Line Indicates the row on which the data to be displayed is entered. 

Column Indicates the column in which the data to be displayed is entered. 

Item Type Selects the type of data to be entered on the screen. The choices are as fol-
lows: 

• User-defined text entry Displays text typed in the Item Value entry.  (24 characters max.) 

• Database value Displays the database value for a selected register. 

• Database Description Displays the database descriptive text for a selected register. 

Item Value Displays the current value of the register; or, if a user-defined text entry is  
selected as Item Type, the text is entered here. 

Format String The format string designates the type of data to be displayed. The strings used 
in the miniBlend.net are based on ISO ‘C’ language standards and are as fol-
lows: 

• %uc Data labeled as "Byte" miniBlend.net (unsigned character) 
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• %f Data labeled as "DP Float" or "Double Precision Floating Point." Specify the 
length of the numeric data in this field. (The miniBlend.net stores all double pre-
cision floating point data as ten digits.) Using the number 0.2 between the "%" 
and the "f" right-justifies the data five places and truncates the data to two de-
cimal places (i.e., %0.2f). This field can be used to line up the numerical data on 
the screen by entering an "8" between the "%" sign and the "f" (i.e., %8f). If the 
requirement is to both line up the data and truncate to two decimal places, the 
entry would be %8.2f. 

• %d Data labeled as an integer in the miniBlend.net database. 

• %s Data labeled as a string in the miniBlend.net, consisting of multiple characters. 

Note 1: The "Edit Report Item" dialog box may also be opened by right-clicking on an existing report item, then 
selecting "Properties." 

Note 2: Existing report items may be moved from one location to another on the Report screen by clicking the 
item with the mouse, then dragging it to another position. Hold "Ctrl" while dragging to copy an entry.  This me-
thod may also be used to move or copy items to another report. 

Note 3: The Report Item “REPRINT” should always be included as the first item on any report. 
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To create a customized report, do the following. 

1. Access Report Editor by selecting File|New|Report Configuration from the BlendMate menu bar. A display 
similar to that shown in Figure 17 below will appear. 

 
 

Figure 17    Report Configuration 
 
2. Next, select Edit|Insert New Item… from the BlendMate menu bar. An "Edit Report Item" dialog box will ap-

pear, similar to that shown in Figure 18. 
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Figure 18    Insert/Edit Report Items 
 
3. In the boxes labeled "Line" and "Column," indicate the position of the new report item. In box labeled “Item 

Value” enter the text to be displayed in that position, Line 1, Column 1 – is the upper left-hand corner of the 
report. There are 60 lines and 80 columns on a single page of a BlendMate report. 

4. Next, select "Item Type" from the pull-down menu shown in Figure 18. There are three options: "Run/Program 
Data Value," "Run/Program Data Description," and "User-defined Text." More about these options appears 
later in this subsection.  

5. To display custom information such as a company name, select "User-defined Text," type the desired infor-
mation in the "Item Value" box, and click "OK." The text will appear in the appropriate position on the report 
screen shown in Figure 18.  

6. If "Run/Program Data Value" or "Run/Program Data Description" is selected, click on "Change" beside the 
"Data Register" box. A menu of selections will appear. Choose an item by highlighting and double-clicking. 

7. Note that the format of the new entry must be appropriate for its type. A sample report appears in Figure 20. A 
corresponding table immediately following the figure details the item, entry type, register, format string, posi-
tion, and location for each element on the report. 
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Advanced Report Options 

BlendMate's Report Editor offers certain advanced configuration features that allow the operator to modify format 
strings, as well as the number of digits to be printed. Normally, no modification is required. BlendMate follows the 
"C" programming language standard for the "printf" function format string. 

To access the Report Editor's advanced features, choose Edit | Insert New Item… from the BlendMate toolbar. A 
dialog box, similar to that shown in Figure 18, will appear. Use the mouse to click on the "Advanced" button in the 
lower right-hand corner of the screen to obtain the dialog box shown in Figure 19. 

 

 

 

 

 

 

 

 

Figure 19    Edit Report Item 
 

 
 
Use Alternate Print Format 

The primary benefit to the "Use Alternate Print Format" feature is the option of editing field sizes. For example, the 
designation %8.3f indicates a total field size of eight characters, with three numbers to the right of the decimal 
point. The printed report format is XXXX.XXX. To eliminate one decimal place in this example, use the mouse to 
highlight the "3", then type "2". The format string for this report item is now %8.2f and the printed report format is 
XXXXX.XX. 

Reference Register 
This feature allows the selection of an alternate database point that may be used to either determine the offset to 
use for the report item, or aid in determining whether the report item should be suppressed for this printing. 

Use Reference Register Value as Offset for this Item 
If checked, the database value offset specified for this report item (the register specified on the previous dialog) 
will be replaced. The actual offset used to determine the value printed is the value of the reference register. The 
typical application for this feature would be to print the correct recipe name. On the base dialog, the database val-
ue "Recipe ID" may have been selected. On the report, the operator may wish to print the recipe name of the rec-
ipe delivered for this batch; however, the batch data contains only the recipe number. To print the actual recipe 
name, specify the Batch x Recipe number for the reference register and select this checkbox. 
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Restrictions 
This combo box allows the selection of a test function. The miniBlend.net may either print or skip this report item, 
depending on the result of the specified conditional. The default is to always print the entry. 

Always print this entry – The default option. 

Print if value is nonzero – Only print this entry if the value of the entry is greater than zero (database entry types 
only). 

Print if reference value is nonzero – Only print this entry if the value of the database entry specified by the ref-
erence register is zero (any entry type can use this restriction). 

Print if indicated batch was delivered – Only print this entry if the batch offset associated with the entry was de-
livered in the transaction (only valid for database entries with a "batch #" offset). 

Print if reference register's batch was delivered – Only print this entry if the batch offset associated with the 
reference register's batch was delivered in the transaction (the reference register must be a database register with 
a "batch #" offset). 

Print if this product was delivered – Only print this entry if the product offset for this entry was a product deli-
vered in this transaction (only valid for database entries with a "product #" offset). 

Print if reference register's product was delivered – Only print this entry if the product offset for the reference 
register was a product delivered in this transaction (reference register must be a database entry with a "product #" 
offset). 

Print if this recipe was delivered – Only print this entry if the recipe offset for this entry was a recipe delivered in 
this transaction (only valid for database entries with a "recipe #" offset). 

Print if reference register's recipe was delivered – Only print this entry if the recipe offset for the reference reg-
ister was a recipe delivered in this transaction (reference register must be a database entry with a "recipe #" off-
set). 
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Sample Report  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 20    Sample Report
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Figure 21    Sample Report Generation
 

 

Item Type Format String Row Column Where Found 

PRODUCT RECEIPT TICKET User-defined Text %s 2 1  

(Reprint) User-defined Text %s 1 71  

----------------------- User-defined Text %s 3 1  

BILL OF LADING User-defined Text %s 4 1  

Transaction Summary - # User-defined Text %s 4 26  

Transaction End Time Run/Program Data 
Value 

%s 6 1 Transaction Data 

Transaction Start Time 
Run/Program Data 

Value  9 1 Transaction Data 

HM Classification: User-defined Text %s 12 1  

102 HM Class Part 1(1) Run/Program Data 
Value 

%s 12 20 Product Configuration 

103 HM Class Part 2(1) 
Run/Program Data 

Value %s 12 40 Product Configuration 

104 HM Class Part 3(1) 
Run/Program Data 

Value 
%s 12 60 Product Configuration 

105 HM Class Part 4(1) Run/Program Data 
Value 

%s 13 1 Product Configuration 
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Customer:_________ User-defined Text %s 14 1  

Carrier: ___________ User-defined Text %s 15 1  

Operator:_________ User-defined Text %s 16 1  

Transaction Totals User-defined Text %s 23 13  

----------------------- User-defined Text %s 24 13  

----------------------- User-defined Text %s 24 36  

IV ( User-defined Text %s 25 13  

114 Volume Descriptor 
Run/Program Data 

Value %s 27 17 System Configuration 

) User-defined Text %s 25 21  

GV ( User-defined Text %s 25 25  

114 Volume Descriptor Run/Program Data 
Value 

%s 25 29 System Configuration 

GST ( User-defined Text %s 25 37  

114 Volume Descriptor 
Run/Program Data 

Value %s 25 42 System Configuration 

) User-defined Text %s 25 46  

GSV ( User-defined Text %s 25 50  

114 Volume Descriptor Run/Program Data 
Value 

%s 25 55 System Configuration 

) User-defined Text %s 25 59  

MASS ( User-defined Text %s 25 62  

114 Volume Descriptor 
Run/Program Data 

Value %s 25 68 System Configuration 

) User-defined Text %s 25 72  

AVG TEMPS User-defined Text %s 25 77  

--------- User-defined Text %s 26 13  

--------- User-defined Text %s 26 25  

--------- User-defined Text %s 26 37  

--------- User-defined Text %s 26 50  

--------- User-defined Text %s 26 62  

--------- User-defined Text %s 26 77  

101 Product ID(1) Run/Program Data 
Value 

%s 27 1 Product Configuration 

Batch P1 Indicated Volume 
(IV)(1) 

Run/Program Data 
Value %10.2f 27 12 Product Run Data for Batch 

Batch P1 Gross Volume 
(GV)(1) 

Run/Program Data 
Value 

%10.2f 27 24 Product Run Data for Batch 
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Batch P1 Gross @ Std 
Temp (GST)(1) 

Run/Program Data 
Value %10.2f 27 36 Product Run Data for Batch 

Batch P1 Gross @ Std 
Temp & Press (GSV)(1) 

Run/Program Data 
Value %10.2f 27 49 Product Run Data for Batch 

Batch P1 Mass Total(1) Run/Program Data 
Value 

%10.2f 27 61 Product Run Data for Batch 

P1 Average Temperature(1) Run/Program Data 
Value 

%6.1f 27 77 Product Run Data for Batch 

101 Product ID(2) 
Run/Program Data 

Value %s 28 1 Product Configuration 

Batch P2 Indicated Volume 
(IV)(1) 

Run/Program Data 
Value %10.2f 28 12 Product Run Data for Batch 

Batch P2 Gross Volume 
(GV)(1) 

Run/Program Data 
Value 

%10.2f 28 24 Product Run Data for Batch 

Batch P2 Gross @ Std 
Temp (GST)(1) 

Run/Program Data 
Value 

%10.2f 28 36 Product Run Data for Batch 

Batch P2 Gross @ Std 
Temp & Press (GSV)(1) 

Run/Program Data 
Value %10.2f 28 49 Product Run Data for Batch 

Batch P2 Mass Total(1) Run/Program Data 
Value 

%10.2f 28 61 Product Run Data for Batch 

P2 Average Temperature(1) 
Run/Program Data 

Value %6.1f 28 77 Product Run Data for Batch 

TOTAL: User-defined Text %s 31 1  

Indicated Volume (IV) 
Run/Program Data 

Value 
%11.2f 31 11 Transaction Data 

Gross Volume (GV) Run/Program Data 
Value 

%11.2f 31 23 Transaction Data 

Gross @ Std Temp Volume 
(GST) 

Run/Program Data 
Value %11.2f 31 35 Transaction Data 

Gross @ Std Temp & Press 
(GSV) 

Run/Program Data 
Value %11.2f 31 48 Transaction Data 

Mass Run/Program Data 
Value 

%11.2f 31 60 Transaction Data 

LOAD AVERAGES User-defined Text %s 36 1  

Temp: User-defined Text %s 36 19  

Average Temperature 
Run/Program Data 

Value 
%6.1f 36 25 Transaction Data 

Dens: User-defined Text %s 36 48  

Average Density Run/Program Data 
Value 

%6.1f 36 54 Transaction Data 

Pres: User-defined Text %s 37 19  

Average Pressure 
Run/Program Data 

Value %6.1f 37 25 Transaction Data 

MFac: User-defined Text %s 37 48  

Average Meter Factor Run/Program Data 
Value 

%7.5 37 57 Transaction Data 

Alarms: User-defined Text %s 43 1  

1st Alarm in Transaction 
Run/Program Data 

Value %s 43 9 Transaction Data 

2nd Alarm in Transaction Run/Program Data 
Value 

%s 43 22  

3rd Alarm in Transaction Run/Program Data 
Value 

%s 43 25  

4th Alarm in Transaction Run/Program Data 
Value 

%s 43 48  

5th Alarm in Transaction 
Run/Program Data 

Value %s 43 61  
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6th Alarm in Transaction 
Run/Program Data 

Value %s 44 9  

7th Alarm in Transaction 
Run/Program Data 

Value %s 44 22  

8th Alarm in Transaction Run/Program Data 
Value 

%s 44 35  

9th Alarm in Transaction Run/Program Data 
Value 

%s 44 48  

10th Alarm in Transaction 
Run/Program Data 

Value %s 44 61  

11th Alarm in Transaction 
Run/Program Data 

Value 
%s 45 9  

12th Alarm in Transaction Run/Program Data 
Value 

%s 45 22  

13th Alarm in Transaction 
Run/Program Data 

Value %s 45 35  

14th Alarm in Transaction 
Run/Program Data 

Value %s 45 48  

15th Alarm in Transaction Run/Program Data 
Value 

%s 45 61  

16th Alarm in Transaction Run/Program Data 
Value 

%s 46 9  

17th Alarm in Transaction 
Run/Program Data 

Value %s 46 22  

18th Alarm in Transaction Run/Program Data 
Value 

%s 46 32  

19th Alarm in Transaction Run/Program Data 
Value 

%s 46 48  

20th Alarm in Transaction 
Run/Program Data 

Value %s 46 61  

This is to certify that… User-defined Text %s 49 1  

the above named material User-defined Text %s 49 25  

ls are properly classif User-defined Text %s 49 48  

ied, User-defined Text %s 49 71  

described, packaged, ma User-defined Text %s 50 1  

rked, and labeled and a User-defined Text %s 50 24  

re in proper condition User-defined Text %s 50 47  

For User-defined Text %s 50 70  

transportation accordin User-defined Text %s 51 1  

g to the applicable DOT User-defined Text %s 51 24  

regulations. User-defined Text %s 51 48  

__________________ User-defined Text %s 54 1  

__________________ User-defined Text %s 54 24  

Driver Signature User-defined Text %s 55 1  

__________________ User-defined Text %s 59 24  

Signature of Receiving User-defined Text %s 60 1  

Agent User-defined Text %s 60 24  
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Note: The first entry on any report should be the text "Reprint." This text will only appear on reports that are reprinted; it will not appear on the 
first report printed. 
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Translation Editor 

The BlendMate's Translation Editor makes it possible to replace any of the text literals in the miniBlend.net with 
customized text. The interface consists of a list view with the original text in the left-hand column and an edit 
space in the right-hand column, as shown in the figure below. The Translation Editor is accessed by selecting 
File|New|Translation from the BlendMate toolbar or by opening an existing translation (.LGB) file. 

 
 

Figure 22    Translation
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A search feature allows the operator to quickly locate a specific entry by matching the text in either the original or 
translated literal. To use the search feature, select Edit|Find (with the Translation Editor open). A dialog box simi-
lar to that shown in the figure below will appear on the screen. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 23    Search for Text 
 
 
To conduct a search, type the desired text in the "Text to Find" box, specify the direction of the search, and click 
"Find." The specified text will be highlighted. Additional search options, "Ignore Case" and "Find From Cursor," 
are located on the left-hand side of the dialog box. Select these options, if desired, by using the mouse to click in 
the box to the left of each option. An "x" will appear in the box. 
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To change a text literal, take the following steps. 

1. Double-click on the literal to be edited. A dialog box, similar to that shown in Figure 24, will appear on the 
screen. 

2. Type the new text in the space on the bottom half of the dialog box.  

3. Click "OK" to exit and save changes, "Cancel" to abandon the change, or "Help" for more information about 
this function. Assuming that new text was entered, it will appear to the right of the Translation Editor screen, 
as shown in Figure 25. The new literal, once downloaded to the miniBlend.net, will appear in place of the orig-
inal literal. 

 

 

Figure 24     Editing Text
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Figure 25     Translation Screen
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Display Configuration Editor 

The Display Configuration Editor allows the user to customize the layout of the miniBlend.net’s Run Display.  The 
Display Configuration is very similar in functionality to the Report Editor. The Display Configuration workspace is 
limited to 8 lines and 21 columns. Access the Report Editor by selecting File|New|Report Configuration from the 
BlendMate menu bar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 26     Display Configuration 
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Like the Report Editor, the Display Configuration process uses a dialog box to define each of the items found on 
the display. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 27     Display Item
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BlendMate Equation Editor 

The BlendMate makes it easy for the operator to direct the miniBlend.net to perform certain functions that are ex-
ecuted on a periodic basis. The BlendMate Equation Editor allows the operator to create application specific cal-
culations, as well as to insert, delete, reorder, and edit existing equation lines. The Equation Editor is accessed by 
selecting File|New|Equation Set. Doing so will result in a display similar to that shown in the figure below. 

 

Figure 28     Equation Programming Screen 
 

Next, select Edit|Insert New to obtain the dialog box shown in Figure 29. Use the pull-down menu at the top of the 
display to indicate the type of equation to be set. An explanation of Boolean and algebraic expressions is included 
in the next subsection of this manual. 
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Figure 29  Equation Editor 
 
 
Boolean/Algebraic Statements 

Boolean statements have two conditions: “true” or “false.”  They may also be represented as "on" or "off," or as in-
teger values from 0 to 255. Any non-zero value is considered true; zero is false. Boolean statements can be used 
to create customized instructions to monitor inputs, control outputs, and calculate report values. The instructions 
are defined at the BlendMate, then downloaded to the miniBlend.net. The different ways of expressing Boolean 
statements are shown below: 

 TEMPBOOL1 = true   
 TEMPBOOL1 = on Equivalent statements  
 TEMPBOOL1 = 1   
    
 TEMPBOOL2 = false   
 TEMPBOOL2 = off Equivalent statements  
 TEMPBOOL2 = 0   
 

The logical operators used in conjunction with Boolean statements are “NOT”, “AND”, “OR”, and “XOR”.  

Refer to these definitions when studying the examples below: 
• TEMPBOOL1 = True 
• TEMPBOOL2 = True 
• TEMPBOOL3 = False 

NOT A Boolean logic operator indicating negation. A variable designated with a “NOT” in 
front of it will be the opposite of its current value. It is a switching function for one va-
riable. 

Example: TEMPBOOL4 = NOT TEMPBOOL3 (True) 

AND A Boolean logic operator. If two variables are involved, both must be true for the out-
put to be true. 
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Example: TEMPBOOL5 = TEMPBOOL1 AND TEMPBOOL2 (True) 
Example: TEMPBOOL6 = TEMPBOOL1 AND TEMPBOOL3 (False) 

OR A Boolean logic operator. Using two variables, only one needs to be true for the out-
put to be true. 

Example: TEMPBOOL7 = TEMPBOOL1 OR TEMPBOOL3 (True) 

XOR An exclusive or Boolean logic operator in which the output is true if either of two va-
riables is true but not if both are true. 

Example: TEMPBOOL8 = TEMPBOOL1 XOR TEMPBOOL3 (True) 
Example: TEMPBOOL9 = TEMPBOOL1 XOR TEMPBOOL2 (False) 

 
Algebraic operators used in conjunction with algebraic statements are as follows: 

• “ + ” - Used to add two numerical values (2 + 2 = 4) 
• “ - ” - Used to subtract two numerical values (4 - 2 = 2) 
• “ * ” - Used to multiply two numerical values (2 * 2 = 4) 
• “ / ” - Used to divide two numerical values (1/2 = 0.5) 
• “ABS” - Used when the absolute value of a number is required ( | -2 | = 2) 
• “POW” - Used to take a number to a power (2POW2 = 22) 

 
Conditional operators used in conjunction with Boolean and algebraic statements are as follows: 
 
• “IF” - Used in statements where if a condition exists, then another event is to occur 
• “ < “ - Less than (1 < 2) 
• “ > ” - Greater than (2 > 1) 
• “ <= “ - Less than or equal to (1 <= 2) 
• “ >= “ - Greater than or equal to (2 >= 2) 
• “ = “ - Equal to (1 = 1) 
• “ != “ - Not equal to (1 ! =  5) 
 

All processing is from left to right and top to bottom 

Example:  1   +   3   *   4   /   2   -   1   

       4 

   16  

           8 

        
                                                  7 
 

There are 50 Boolean registers and 50 float registers. The maximum number of instruction lines per equation set 
is 50, and the maximum number of operations per statement is 4. All Boolean and algebraic equations for a mini-
Blend.net must be stored in a single file, and all changes to equations must be made in this file. 
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 Specific Boolean Expressions 

When constructing a set of equations that take action based on a level value (such as a temperature, a status 
value, the state of a digital I/O point, or any other value that may change between the evaluation of one equation 
and the next), read the value into a temporary or user-defined variable (Boolean or float, as applicable) and use 
the variable, not the actual value, in multiple equations. 

Boolean equations can be more clearly expressed as a result of an evaluated expression than by assigning a val-
ue conditionally. For example, let us assume that we want to turn on a digital output when the product tempera-
ture of the meter is between 70° and 90°, inclusive, and turn the same digital output off again when the tempera-
ture is no longer within that range. Because of the left-to-right evaluation of Boolean and algebraic expressions, it 
is recommended that the expressions be broken down into simple expressions so that the results are as ex-
pected. 

TEMPBOOL1 = Product Run Data (1) Current Product Temperature >=70 
TEMPBOOL2 = Product Run Data (1) Current Product Temperature <=90 
OUTPUT1 = TEMPBOOL1 AND TEMPBOOL2 

 

Setting a Timer 

Eight timers are available in the miniBlend.net. The breakdown is as follows: 

• 2 - 0.1 (Tenth) Second 
• 2 - 1 (One) Second 
• 2 - 1 (One) Minute 
• 2 - 1 (One) Hour 
 
A timer can be started by writing a 1 to it, and reset by writing a 0. Timers will hold values from 0 to 65535. To in-
struct a time to count down, set it to a negative number. For example, if Timer3 is set to –20, it will stop in 20 
seconds. If a continuously running timer is desired, include a line in the expression that resets the timer to 1 when 
it stops. 
 

Timer3 = 1 IF Timer3 = 0 
 

Setting an Alarm 

Five user alarms are available in the miniBlend.net. These alarms are programmable, and clearable in Run or 
Ready mode. A text string of up to 18 characters may be associated with each alarm. The set commands availa-
ble are as follows: 

• Set Alarm Output #1 

• Set Alarm Output #2 

 

Inputs and Outputs 

The miniBlend.net can monitor any of the 3 digital and 2 analog inputs, and control any of the 6 digital outputs us-
ing operator-configured Boolean commands. Outputs can be configured for general purpose applications, and can 
be turned on or off by equations. 
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Variables and Registers 

Temporary variables include the following: 

• TEMPBOOL1 to TEMPBOOL50 
• TEMPFLOAT1 to TEMPFLOAT50 
• Place holders used by other instruction lines. 
 
 
User memory consists of the following: 
 
 
• USERBOOL1 to USERBOOL50 
• USERFLOAT1 to USERFLOAT50. 
 
All variables and registers can be read and written to by equations. They can also be accessed via BlendMate 
communications and their values included in user-configured reports.  
 
 
 
Possible Boolean Applications 

In addition to the applications listed above, several other operations can be initiated or controlled using Boolean 
equations. These include the following: 

• Temperature calculations (C, F or K) 
• Temperature monitor to turn output on. 

 
 
Example A: Turn on digital output #1 when the product temperature is between 175° and 250°. 

TEMPBOOL1 = Product Run Data (1) Current Product Temperature >= 175 
TEMPBOOL2 = Product Run Data (1) Current Product Temperature <=250 
TEMPBOOL3 = TEMPBOOL1 AND TEMPBOOL2 
OUTPUT1 = ON if TEMPBOOL3 
OUTPUT1 = OFF if NOT TEMPBOOL3 

or 

TEMPBOOL1 = Product Run Data (1) Current Product Temperature >=175 
TEMPBOOL2 = Product Run Data (1) Current Product Temperature <=250 
OUTPUT1 = TEMPBOOL1 AND TEMPBOOL2 

Both of these groups of statements will yield the same results. Note that Product Run Data (1) Current Product 
Temperature appears as Register 68092929 when selected and before moved to the file. 

Example B: Convert the current temperature (Celsius) to Fahrenheit 

USERFLOAT1 = Product Run Data (1) Current Temperature * 1.8 + 32 

Note that the current temperature register is 68092929. 
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Algebraic Expressions 

The miniBlend.net converts all algebraic values to double precision floating point values prior to performing calcu-
lations. 

Calculations may be defined using positive or negative whole numbers, fractional numbers, or a combination. Al-
gebraic expressions are evaluated from left to right and all operators (+, -, /, *) have the same precedence. Multip-
lication does not take place before addition, etc. The following expression has a result of 54. 

TEMPFLOAT1 = 4 + 5 * 6 (Result 54, 4 + 5 = 9 * 6 = 54) 

Algebraic processing will allow out of range values, such as division by zero, or evaluations of expressions whose 
results are greater than the range of a double precision floating point variable. It is the responsibility of the user to 
ensure that valid expressions are used. 



Section VI – Related Publications 

BlendMate for miniBlend.net 

BlendMate for miniBlend.net Installation/Operation............................................................................. Bulletin MNMB006 

miniBlend.net 
Specification ........................................................................................................................................... Bulletin SSMB001 
Installation ............................................................................................................................................. Bulletin MNMB001 
Operator Reference .............................................................................................................................. Bulletin MNMB002 
Operations ............................................................................................................................................. Bulletin MNMB003 
Communications ................................................................................................................................... Bulletin MNMB004 
Modbus Communications ..................................................................................................................... Bulletin MNMB005 

© Guidant Corporation 2025 All rights reserved.  

www.GuidantMeasurement.com 

USA Operation 
1602 Wagner Avenue
Erie, Pennsylvania 16510 USA
P:+1 814.898.5000

Germany Operation 
Smith Meter GmbH
Regentstrasse 1
25474 Ellerbek, Germany
P:+49 4101 304.0


	BlendMate( for miniBlend.net
	Caution
	Disclaimer
	Figure 23    Search for Text
	Figure 24     Editing Text
	Figure 25     Translation Screen
	Figure 26     Display Configuration
	Figure 27     Display Item
	Figure 28     Equation Programming Screen
	Figure 29  Equation Editor
	BlendMate for miniBlend.net
	miniBlend.net





